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What is the HA Cloud Connector?

Designed especially for use with an Edgenexus EdgeADC pair within Cloud environments such as
Microsoft Azure, or Amazon AWS, the HA Cloud Connector (HACC) monitors the ADC and Applications for
availability. It communicates with the cloud system API to move elastic, or floating IPs to the secondary
failover ADC, or vice versa, and ensure continuous availability.

Why is HACC needed?

Normally, within LAN environments you do not need to have something like HACC. In a LAN we can create
any IP within our IP segment, address it, and utilise it when we need to. This is not the case within Cloud
environments, as they are compartmentalised and highly restricted in terms of users being able to do what
every they wish.

This means that setting up load balancers in HA pairs is extremely complex and requires the use of the
cloud providers’ own load balancer to distribute the floating IP.

HACC has been designed and built to alleviate this issue allowing users to have HA pairs of load balancers
without the use of the cloud provider load balancer as an IP address distributor.

How does it work?

The HACC works by utilising a special monitoring Virtual Service, whose job is to monitor, not just the
connection to the Real Servers but also the active ADC through its HA passive partner, and work with
Cloud provider's API to move the floating IP to the passive ADC, and thus enact the failover.

Important:

It must be noted that you can only form an ADC pairing for floating IP switching within a region. You can have the
ADCs located in different zones, but the network must be contiguous.
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Prerequisites and Architecture

Important

The HACC App and functionality is designed to work within the same Cloud region. It cannot operate
across regions. You can however use it across two zones, if there is a contiguous network linking the two

zones.

e e
@ N «—x— < O

e
>

@ CONTIGUOUS SUBNET @

LI ~—,—

Prerequisites
To use the HACC, you need to fulfil certain prerequisites.

1. You must have TWO Edgenexus ADCs configured and running within the Cloud region.
2. The VIP/VS configurations, except for the IP address of the Monitoring Service should be replicated.

3. The ADCs must be configured as stand-alone devices.
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4. You require TWO network interfaces. Let’s call them NIC-1 (eth0) and NIC-2 (ethl).

5. NIC-1 on each ADC must have a Cloud Public IP and is used to handle ADC management. If you are
accessing it from an internal Cloud resource for security purposes, then you do not need to have the Public IP
and can use the Private IP for management access.

6. Associate the floating IP with NIC-2 on ADC 1.

The floating IP can be a Public IP linked to NIC-2, or several Private IP addresses also linked to NIC-2, or
both — you will need to define HACC Services for each floating IP.
The HA Cloud Connector App uses this and will switch this automatically to NIC-2 on ADC2 when required.

Architecture

Below is our sample architecture.

ADC PRIMARY ADC SECONDARY
NIC1 NIC1
10.0.0.4 10.0.0.5

PUBLIC IP FOR MANAGEMENT

/ 40.81.137.53

PUBLIC IP FOR MANAGEMENT

40.81.137.122 \

ADC ADC
VIP 10.0.1.112 PRIMARY SECONDARY VIP 10.0.1.112
VIP 10.0.1.114 INSTANCE INSTANCE VIP 10.0.1.114
ACTIVE STANDBY
ADC PRIMARY ADC SECONDARY
NIC2 NIC2
10.0.1.110 10.0.1.110
FIP 10.0.1.112
FIP 10.0.1.114
USED FOR ELASTIC HA USED FORELASTIC HA

Third Party Firewall

Using Public IP Private IP Connection

.. _‘A'--I
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Understanding the Logic Flow

Refresh data from:
Cloud Configuration API
ADC Monitoring API
App Configuration DB

Monitoring VS Switch Floating Address(s) to
Online? Preferred Destination

Set Failover Status to Inactive

Switch Floating Address(s) to the
Destination other than Current
Destination

Set Failover Status to Active

© 2024 Edgenexus Limited 7 | Page



HA Cloud Connector — for Azure

Installation & Configuration Guide

Microsoft Azure

© 2024 Edgenexus Limited 8| Page



HA Cloud Connector — for Azure

Installation & Configuration Guide

Important - Using Tags

We strongly advise that you define each element you configure, with a TAG or name.

This makes it easier to select the right elements when configuring the HA Cloud Connector, and the lack of
tags not only makes it more difficult, but also may lead to incorrect operation of the product leading to
increased support.

For example, we have named our VMs JS-HACC-VM1-UKS-Z1. This allows us to easily see that JS has
created a HACC VM number 1, in the UK South region’s Zone 1.

Similarly, we also name our NICs. For example, HACC-VM1-NIC2.
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Preparing Azure for HACC

To create the Azure environment for use with HA Cloud Connector, you will need to follow the stages
below.

Creating the App registration

In order to use an App to communicate with Azure’s API, you are required to first register it. This process is
called App Registration.

e Log into the Azure portal.

o Navigate to Microsoft Entra ID. You can find this by typing Entra ID into the search field at the top, or clicking
the icon if it is already visible.

_ S SRS S _

Azure services

(1] (0
( e | :
+ | & | #E @ 2 a8 -
Create a Resource Microsoft Entra App Network Virtual Subscriptions Network Marketplace More services
resource groups ID registrations security groups machines Watcher

On the next screen (shown below) you need to click the small arrow next to the Add button (highlighted),
and choose App registration.

= Microsoft Azure £ Search resources, services, and docs (G+/) -

Home >

o edgeNEXUS Limited | Overview

Microsoft Entra ID
« -+ Add v [ Manage tenants What's new [Fd Preview features 2 Got feedback? v

@ Azure Active Directory is now Microsoft Entra ID. Learn more [3

O Overview

I Preview features

#  Diagnose and solve problems Overview Monitoring Properties Recommendations Tutorials

~+ Add v 0% Manage tenants What's new 5, Preview features a4/ Got feedback?
User > ,
now Microsoft Entra ID. Learn more [3

Group , . .
Properties Recommendations Tutorials

Enterprise application

I App registration I

The following screen will display a form that is very easy to fill in.
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Home > edgeNEXUS Limited | App registrations

Register an application %

* Name

The user-facing display name for this application (this can be changed later)

Supported account types

Wha can use this application or access this API?

ounts e.g. Skype,

henticating the user. Providing this now is optional and it can be

ery apps and other apps from outside your

Provide a name for the application and click Register. We have used the AppName of Edgenexus HA
Cloud Connector, but you can use anything that suits you.

On the next screen, you will see the Certificates & Secrets for the Application.

= Microsoft Azure 2 Search resources, services, and docs (G+/) .

Home > edgeNEXUS Limited | App registrations > Edgenexus HA Cloud Connector

Edgenexus HA Cloud Connector | Certificates & secrets »

| £ search | « &7 Got feedback?

2 Overview

& Quickstart Credentials enable confidential applications to identify themselves to the authentication service when receiving tokens at a web addressable location (using an HTTPS
scheme). For a higher level of assurance, we recommend using a certificate (instead of a client secret) as a credential.
F 4 Integration assistant

Manage %
o Application registration certificates, secrets and federated credentials can be found in the tabs below.
2 Branding & properties
3) Authentication " . .
Certificates (0) Client secrets (1)  Federated credentials (0)

Certificates & secrets
. A secret string that the application uses to prove its identity when requesting a token. Also can be referred to as application password.
11! Token configuration
- APl permissions —+ New client secret
& Expose an APl Description Expires Value Secret ID
“4 Approles HACC-Secret-21-FEB-24 2/20/2026 JPyik sk ok 80a 47be [y il
2 Owners

4o Roles and administrators

Kl Manifest

Support + Troubleshooting
&% Troubleshooting

£ New support request

NOTE: It is very important that you make a note of the content in the VALUE field. This is also referred to as the Client
Secret and is required within the HACC application.

This concludes the App Registration section.

Creating a Resource Group

We advise you to create two Resource Groups for holding the two ADCs and their respective assets. In our
case, we have created two Resource Groups called HACC_1 and HACC_2.
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To create a Resource Group, type resource group in the search bar. This will show you the icon for the

Resource Group section. Click this and go to the Resource Group section.

Home

Resource groups <

edgeNEXUS Limited (edgenexus.io)

| Create i Manage view () Refresh | Exportto CSV % Open query

Filter for any field. Subscription equals all Location equals all > T Add filter
Showing 1 to 40 of 40 records.

| Name

| (%) Det

| (%] Det

| (%] Det

J (%] Det

| (%] Det

J (%] Det

] (4] Edg
| (%) Ede
| (%] edc
] (%) ca
] (%] Gre
| (] Gre

[
l
[
[
[
[
[
[ (%) oo
[
[
[
[
[
[
[

| (%] Gre

Page | 1 v |of1 | Next

Subseription T

Edgenexus Azure
Edgenexus Azure
Edgenexus Azure
Edgenexus Azure

Edgenexus Azure

Edgenexus s Azure
Edgenexus Azure
Edgenexus Azure
Edgenexus Azure
Edgenexus Azure
Edgenexus Azure
Edgenexus Azure
Edgenexus Azure

Edgenexus Azure

No grouping || EE List view v

Location T,
NOFIN Europe
Wast Europe
North Central US
West Europe

UK South

West Europe
West Europe

UK South

UK South

UK South

UK West

South Central US
North Europe

North Europe

A Give feedb v

Click Create located at the top left.
= Microsoft Azure

Home > Resource groups >

Create a resource group

Basics Tags  Review + create

J/ Search resources, services, &

Resource group - A container that holds related resources for an Azure solution. The resource group can include all the
resources for the solution, or only those resources that you want to manage as a group. You decide how you want to
allocate resources to resource groups based on what makes the most sense for your organization. Learn more C7

Project details

Subscription * @ ‘ Edgenexus Azure v ‘
Resource group * (O l HACC_1 v l

Resource details

Region * O l (Europe) UK South ~ I

Fill in the details and create the Resource Group. Do this for both groups.

Access Control (IAM) and Roles

The next stage is to set the IAM roles in order for the HACC app to communicate and control aspects of the

Azure infrastructure.

© 2024 Edgenexus Limited
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To do this you need to first access the Subscriptions. We will be creating roles called:

e Network Contributor and
e Virtual Machine Contributor.

Within the Subscription page, click on the Access Control (IAM) link in the left panel.

Edgenexus Azure | Access control (IAM)

Subscription

|/O Search | « + Add i Download role assignments Edit columns C} Refresh X Remove R’j Feedback

Overview Add role assignment

assignments Roles  Deny assignments Classic administrators
Activity log Add co-administrator

Access control (IAM) Add custom role
View my level ot access to this resource.

View my access

Security Check access

Tags

Diagnose and solve problems

Q@ X & ¥ I

Review the level of access a user, group, service principal, or managed identity has to this resource. Learn more o'

Events

Cost Management

S, Cost analysis

Grant access to this resource View access to this resource View deny assignments
B3 Costalerts
i Budgets Grant access to resources by assigning a role. View the role assignments that grant access View the role assignments that have been
Learn more (' to this and other resources. denied access to specific actions at this
@ Advisor recommendations Learn more (' scope.

Learn more
Billing

Now click Add Role Assignment as shown above. The screen you will see is one like below. Type Network
Contributor in the search box and select the Network Contributor option as shown below.

Home > Edge_HACC_1 | Access control (1AM)

Add role assignment X

Role  Members

Review + assign

Ao

Job function rales  Privileged administrator roles

Grant access 1 Azure resources based an job function, such as the ability 1o create vietual machines

network contr Type  All Category : All

Name T Description 14 Type L Catogory T4 Detaits
Classic Network Contributor Lets you manage classic networks, but not access to them BuitiinRole Networking

Classic Viriual Machine Contributor Lets you manage classic virtual machines, but not access ta them, and not the viriual network or storage account they're connected to BuifiinRole Compute View
Damain Services Contributor Can manage Azure AD Domain Services and related network configurations BuittinRole denti jew
Network Contributor Lets you manage networks, but nat access 1o them. BuitinRale Networking View
Private DNS Zone Contributar Lets you manage private DNS zone resources, but not the viriual networks they are linked {0 BulliinRole Networking

5L Managed Instance Conrlbutor Lets you manage SQL Managed Insiances and requir ion, but can't give access to others BuitiinRole Dotabases

Virtual Machine Contributar Lets you manage virtual machines, but not access to them, and net the virtual network or storage account they're connected to BuirtinRole Compute View
Windows 365 Network Interface Coniributor This role s used by Windows 365 to provision required network resources and join Microsoft-hosted VMs to network interfaces. BuitiinRole None ew

Showing 1 - 8 of 8 results

Now click the +Select Members link as seen below, and then click Next.
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Home > Edge HACC_1| Access control (IAM)

Add role assignment

Object 1D Type

Description

Q

You will now see the box shown below on the right side. Select the application you registered. In our case it
looks like the image below.

Select members

Select (O

[ Edge

Edgenexus Azure AD integration

Edgenexus HA Cloud Connector

Edgenexus Tecnnicar presaes

EdgenexusPreSales@edgenexus.io

Now repeat the steps above to add the Virtual Machine Contributor role.

When done, go to the Home page of your portal to proceed to the next steps.

© 2024 Edgenexus Limited 14 | Page
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Creating the ADC Virtual Machines

Now comes the main step — creating the EdgeADC virtual machines. We will be creating two virtual
machines, both in the same region and zone.

In the main portal, click the Virtual machines icon.

Azure services

1] m
4 T S
+ ||H ® & # ¢ 2 a -
Create a Virtual Resource Microsoft Entra App Network Subscriptions Network Marketplace More services
resource machines groups D registrations security groups Watcher

In the next screen click on the Create menu and select Azure virtual machine from the dropdown.

Home

Virtual machines =

edgeNEXUS Limited fedgenexus.ia)

+ Create & Switchtoclassic (D) Reservations &} Manageview () Refresh L ExporttoCSV % Open query v P Maintenance
Type equals all Resource group equals all ¢ Location equals all % T Add filier
No grouping | [E= Listview

Virtual machine

Virtual machine

Type Ty Subscription T, Resaurce group T4 Location T4 Status T4 Operating system T4 size T4, Public IP address T4 Disks T,
1
1
1

Virtual machine

You will now come to the pages where you set up your virtual machine for the EdgeADC.

Home

Create a virtual machine

Basics  Disks 9 Advanced  Tags  Review + create

Create a virtual machine that runs Linux or Windows. Select an image from Azure marketplace or use your own customized
image. Complete the Basics tab then Review + create to provision a virtual machine with default parameters or review each tab
for full customization. Learn more 7

Project details

Select the subscription to manage deployed resources and costs. Use resource groups like folders to organize and manage all
your resources.

Subscription * Edgenexus Azure
Resource group * @ I\ Edge_HACC_1 v \I
oY

Instance details

Virtual machine name * |[s-Haccvm- |
Region* (Europe) UK South v
Availability options Availability zone v
Availability zone * G [ Zones 1 |

@ You can now select multiple zones. Selecting multiple zones will create one VM
per zone, Learn more o

Security type Trusted launch virtual machines

Configure security features

Image * (i Ubuntu Server 20.04 LTS - x64 Gen2 v
See all images | Configure VM generation

VM architecture () O Ame4
®) x64

Run with Azure Spot discount )

[ Roview + st ] iois | [ Nexoms> |
This is the first page of the VM setup. In the image above, we have indicated the fields that need to be
selected.

e Select the Resource Group for ADC1 VM
e Give it a VM name of your choice
e Choose the Region and Zone — Need to be in the same region and zone

© 2024 Edgenexus Limited 15| Page
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e Choose Standard as the Security type
e Click the See all images link.
e When the Marketplace comes up, search for Edgenexus

Recently created —_—
E 1) ’
Private products —_—

Edgenexus EdgeADC -
Advanced Load Balancer for

Categories
edgeNEXUS
Networking (3) Virtual Machine
i Easy to use -Load balancer/ADC, SSL
Security 2) offload, Caching, Acceleration, Traffic
M t and App St
Web &) anagement and App Store
Al + Machine Learning (0) Starts at
£0.148/hour
Analytics (0)
Select <@
Blockchain (0)
Application Load Balancer / ADC - unrestricted - x64
Compute (0) Gen 1
Containers (0) 3G Application Load Balancer / ADC - x64 Gen 1
Databases (0)  BYOL Application Load Balancer / ADC - x64 Gen 1
DevOps (0) 500Mb Application Load Balancer / ADC - x64 Gen 1

1 Gbps Application Load Balancer / ADC - x64 Gen 1
Developer Tools (0)

10G Application Load Balancer / ADC - x64 Gen 1

T & Management Tools (0)

e Choose the type of EdgeADC licensing model you need.
If you are installing your own license purchased from Edgenexus, choose the BYOL option, otherwise choose
one of the times/sized license options.

e You will then be taken back to the virtual machine creation page.

e Click the Next: Disks button.

e On the Disks page we have highlighted the options need changing.

Home

Create a virtual machine x

‘The size of the VM determines the type of storage you can use and the number of data disks allowed. Lear more o
VM disk encryption

‘Azure disk storage encryption automatically encrypts your data stored on Azure managed disks (05 and data disks) at rest by
default when persisting it ta the cloud

Encryption at host ()
@ Erwryption st hast is not registired for the salectad subicrigion.
Leasn, more about enabling this feature o
05 disk
05 disk size () [ 2268 ey v \l

@ Some images are, by default, smaller than the selected 05 disk size.
Slick here o leam horw fo expand your disk :

M

05 disk type * (0 I Standard SSD (locally-redundant storage) ~ I

high IOPS workloads. Virtual machines with Premium SSD disks qualify for the 99.9%
connectivity SLA.

Delete with VM () =
Key management () Platiorm-managed key -
Enable Ultra Disk compaticity O

Data disks for JS-HACC-VM-UKS-Z1

You can add and configure additional data disks for your virtual machine or attach esisting disks. This WM also comes with a
temporary disk

N Name Size (GiB)  Disk type Hostcaching  Delete with VM ()

Create and attach a new disk  Attach an existing disk

[ = Prevows [ st Nerworiing =] R G testvacs @

e Choose the Disk size (we recommend 40GB but the nearest is 64GB).

e Choose the OS Disk Type as Standard SSD.

e Click Next: Networking.

e You can skip the Management page unless you wish to use it. Click Next: Monitoring.
e Unless you wish to use Monitoring, we suggest clicking the Disable option.
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Home

Create a virtual machine

X
Basics Disks Metworking  Management  Monitoring  Advanced  Tags  Review + create
Configure monitoring aptions for your YM
Alerts
Enable recommended alert rules. () ]
Diagnostics
Boot diagnostics ©) ®
() Enable with custom storage account
() Disable
Enable OS quest diagnostics () (]
Health
Enable application health monitoring @ [
< Previous Next : Advanced > R Give fexcoack (@

e Click on the Review & create button as we have no need to do anything on the Advanced page.

The ADC VM will now be created.

NOTE: These steps will need to be repeated to create the second ADC VM.
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Configuring the Virtual Machine

When you have your Virtual machine created, make sure it is in the Off status, as we cannot make the
changes we need if it is running.

Networking

Home

K3 JS-HACC-VM-UKS-Z1 = X

£ Search & Comnect v [> start t & Capture [i] Detete () Refresh [] Openinmobile &7 Feedback [Z. cLi/PS

B Overview
JSON View

& Acivity log
oup (move) : Edge MACC 1 Operating system Linux

% Access control (IAM)
Standard B2ms (2 vepus, 8 Gi§ memory)

Stopped (deallocated)

@ Tegs UK South (Zone 1) 20 s

X Diagnose and solve problems n(move)  : Edgenexus Azure rk/subnet : JS-HACC-VM-LKS-Z1-vnet/default

Ofa2e 14023 DN Not configured

Connect
= 1 Health state
& Connect

# Tags (edit VM_Name - JS HACC_VM_UKS 21
XX Bastion
Networking

Properties  Monitoring  Capabilities (7)  Recommendations  Tutorials
& Network settings R

© Load balancing B virtual machine

JS-HACC-VM-UKS-Z1

53 ( Network interface js-hacc-vm-uks-21129.21)

© Applcation security groups

& Network manager

Settings

® Disks

&) Extensions + applications.
& Configuration

@ Advisor recommendations
1! Properties

@ Locks

Availability + scale
JS-HACC-VM-UKS-Z1_OsDisk 10845262157 1a49d88fe47c526578daze

Disabled

B size

. Availability + scaling

» Not enabled
. Avsilability + scaling @
Security Ephem N/A

Availabifity zone ~(edit) 1

The first stage of configuring the VM for use with HACC is Networking. The first thing we will do is to add a
new subnet and an additional network interface (NIC).

e Click the Networking link highlighted above.
e This will take us to the Networking page.
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Adding a Subnet

Home > JS-HACC-VM-UKS-Z1

® JS-HACC-VM-UKS-Z1 | Network settings

Virtual machine
2 Search (D This is s new experience. Pinase provide ferdback

T Ovenien & Attach network interface 57 Detach network interface o, View topolegy 12 Troubleshoot () Refresh 37 Give feedback
@ Activitylog

Hetwo
js-hacc

1 Access contral (AM) 1P configuration
R AN o

521129 71 (primary) / ipconfig] (primary)
@ Tags
X Diagnose and solve problems R
Connect Network interface js-hace Load balancers a(co
& Connect Virtual network / subnet | J5-HACK Application security groups
< Bastion Public IP address J5-HACC-VM-UKS-Z1-ip Network security group Edge_HACC_1_NSG.
Private IP address 10004 [ Accelerated networking  © Disabled

Netwarking Admin security rules - D {Configure) Effective security rules
& Network settings
© Load balancing Rules 7% Collapse ol
@ Application security groups.
2 Nework manager o ;’ Netwark security group Edge HACC 1 MSG {attached to networkinterface: js-hacc-vm-uks-21129 21)

Impacts 0 subnets, 1 network interfaces
Setings
® Disks

O Search rules Source == all  Destination == all  Protocol == all  Action == all

@ Baensions + applications.

Priority T Name Fart Protocol Source Destination

& Configuration

@ Advisor recommendations * Inbound port rules (3)

1! Properies

£ Locks

Availability + scale

B size > Outbound port rules (3)
= Availability + scaling

Security

e Click on the Virtual Network/subnet link highlighted.
e You will now be presented with the Add Subnet page shown below.

Add subnet X

Name *
[ HACC_1_Secondary V]

Subnet address range * ©
| 100.1.0/24 |
10.0.1.0 - 10.0.1.255 (251 + 5 Azure reserved addresses)

[ ] Add IPv6 address space @

NAT gateway (O

| None v ‘
Network security group
[ edge_ HACC_1_NSG |

Route table

[ None ~ ]

I Save A7 Give feed V)

e Fill out the field shown in the image above.

Action

e Remember the subnet should be a new one, and it is this subnet that we will use for the floating IP and user

access to the applications.
e Choose the appropriate Network security Group.
e Once done click Save.
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Attach a Network Interface to new Subnet

The next thing to do is to attach a new NIC to the new subnet.

Home > IS-HACC-VM-UKS-Z1

JS-HACC-VM-UKS-Z1| Network settings

virtual machine

A Search (D This is a new experience. Pisase provite feedhack
B Overview - o . o =

' Attach network interface | 57 Detach network interface o View tapology 2 Troubleshoot () Refresh /7 Give feedback
B Activtylog

Hetwor

js-hacc-vm-uks-z1129_z1 (primary) / ipconfig] (primary)

tertace / IP configuration

B2 Access control [IAM)

@ Tags
X Diagnose and soive problems A Essarials
Conmect. Network interface js-hacc-vm-uks-z1129 21 [ Load balancers 0 (Configure]
& Connect Virtual network / subnet : J5-HACC-VM-UKS-Z1-vnet / default Application security groups : 0 (Configurel
% sastion Public P address J5-HACC-VM-UKS-Z1-ip Network securty group  : Edge_ HACE_1_NSG
Private 1P address 10004 Accelerated networking  : Disabled
N ki
etworking Admin security rules - 0 (Configure) Effective security rules 0

& Network settings
A
& Load balancing Rules 7 Collapse all

@ Application security groups

R Network manager " ;’ Netwark security group Edge HACC_1_NSG (attached to networkinterface: js-hacc-vm-uks-21129 2
Impacts 2 subnets, 1 network interfaces
Settings
® Disks
D Search rules Source == all  Destination == all  Protocol == all  Action == all
&) Extensions + applications.
Priority | Hame Part Protocal Source Destination
& Configuration
@ Advsor recommendations ~ inbound port ules (31
1l Properties
@ Lods
Availability + scake
o size > Outbound port rules (3)

B Availabilty + scaling

Security

e Click the Attach Network Interface link indicated in the image above.
e Click the Create and attach network interface link below the drop down that appears.
e You will see the following page

Home > JS-HACC-VM-UKS-Z1 | Network settings >

Create network interface

Name *
[ HACC.VM1_NIC2 7]

Virtual network (O
[ J5-HACC-VM-UKS-Z1-vnet |

Subnet * (O

‘ HACC_1_Secondary (10.0.1.0/24) ~ ‘

TNIC network security group (i)

O None
@ Basic

O Advanced

Public inbound ports * ©
@ None

O Allow selected ports

Select inbound ports

‘ Select one or more ports v

ﬂ All traffic from the internet will be blocked by default. You will be able to
change inbound port rules in the VM > Networking page.

Private IP address assignment
(oymamic
Private IP address *

[ 100.1.100 v

[ private IP address (IPv6)

Accelerated networking O

(Disabled _Enabled )

© 2024 Edgenexus Limited
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e Add a name for the NIC you are creating.
e Choose the new Subnet from the dropdown menu.
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e Make it a Static Private IP address.

e Add an IP address making sure it is in the new subnet.

e Click Create.

e This is the BASE IP Address for this network interface.

Creating IP Addresses for Accessing

Here, there are two choices.

a. Create a Public IP Address and attach it to the network interface you just created.

or

b. Create multiple Private IP addresses so your other internal resources may connect to, and access the

services being provided by the ADC.

Creating a Public IP Address

The Public IP address that we will create is going to serve as the floating IP Address we will use for high

availability.

¢ From the home page of the portal click Create a Resource.

e Select Networking in the left panel or type Public IP Addresses in the search.

e You will see the following page (split into two halves for clarity).

= Microsoft Azure

Home > Create a resource >

Create public IP address

Basics  Tags Review + create

Create a public IP address. Associate it with a virtual machine or other Azure resources. Internet resources communicate to

Azure resources through a public IP address. Learn more

Project details

22 Search resout

Select the subscription to manage deployed resources and costs. Use resource groups like folders to organize and manage all

your resources.

Subscription @ *

Resource group @ *

Instance details

Region @ *

Configuration details

Name *

IP Version * (O

SKU*

© 2024 Edgenexus Limited
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v |

| Edge HACC 1

e ‘

Create new

(Europe) UK South

Deploy 1o an edge zone

| HACC_UKS_ElasticlP

@ P4
O IPv6

@ Standard

O Basic
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e Choose the Resource Group. We have chosen the group that VM1 was created in.

e Choose the Region.

e Specify a name for this floating IP. Essential that this is be done properly so it is recognizable in the HACC
application configuration.

e Choose IP V4 for the IP Version, and Standard for the SKU.

Availability zone * (O ‘ Zone-redundant ~
T‘ *
ter* @ @ Regional

O Global

IP address assignment

Static IPs are assigned at the time the resource is created and released when the resource is deleted. Dynamic IPs are assigned
when associating the IP to a resource and is released when you stop, restart, or delete a resource. Dynamic is only available for
Basic SKU. Learn more

IP address assignment * (O .
Dynamic

@ Static

Routing preference * © @ Microsoft network

O Internet
Idle timeout (minutes) * (O ‘ 4 ‘
DNS name label (O ‘ hacc ‘

.uksouth.cloudapp.azure.com

Previous Next Review + create

e |Leave the Availability Zone as redundant.

e Leave the Tier as Regional.

e Choose Static as the IP address assignment.

e Choose the Routing Preference as Microsoft Network.

e Provide an appropriate DNS name for the floating IP address. We have chosen HACC for convenience, but
this may be something more relevant to your deployment.
e Click Review & Create.

e You will see the result looking like the following image.

Home >

& PubliclPAddress-ARM | Overview =

Deployment

< [i] Delete " Redeploy L Download () Refresh
2 Ovenview .

. @ Your deployment is complete

&l Inputs

_ E Deployment name : PubliclPAddress-ARM

#= Outputs Subseription Edgenexus Azure

[ Template Resource group Edge_HACC_1

~  Deployment details

Resource

L HACC_UKS_ElasticlP

Correlation 1D : 6b87b437-2384-4a44-a14d-727ale5ae6%0

Operation details

Operation details

NOTE: You need to associate the Public IP with ADC1-NIC2 initiallty, after which the HACC app will handle this

automatically.
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Creating Private IP Addresses
The creation of Private IP addresses is relatively simple.

e We will begin with what we term the Primary ADC.
e Inthe VM settings, navigate to Networking > Network Settings.

e You will then need to use the Network Interface / IP Configuration menu and select NIC-2. This has been
highlighted in the image below.

| - oo EETTETTETE 0 0 0 0 R e

Home > J5-HACC-HA-VMPRI-UKS-Z1

@ JS-HACC-HA-VMPRI-UKS-Z1 | Network settings  + - *

Virtual machine

> Search R
2 seare (& Attach network interface 57 Detach network interface 4 View topology @ Troubleshoot ~ () Refresh &7 Give feedback
BB Overview
B Activity log n Network interface / P(Dn'\qulra'lnn ) o
HA-PRIMARY-NIC-2 / ipconfigl (primary)
Bo Access control (IAM)
@ Tags ~ Essentials
X Diagnose and solve problems Network interface HA-PRIMARY-NIC-2 Load balancers : 0 (Configure)
> Connect Virtual network / subnet 15-HACC-YM-UKS-Z1-vnet / HACC_1_Secondary Application security groups  © 0 (Configure)
~ Networking Public IP address - (Canfigure} Network security group : basicNsgHA-PRIMARY-NIC-2 [y
@ Network settings Private IP address 10.01.102 Accelerated networking : Disabled
Admin security rules 0 (Configure) Effective security rules ‘o

€ Load balancing

@ Application security groups
Rules 7~ Collapse all
& Metwork manager

> Settings

Network security group Edge HACC_1_NSG (attached to subnet: HACC_1_Secondary) _

Ve _HACC 1| 1 Create part rule ~
> Availability + scale Impacts 2 subnets, 3 network interfaces islCrestaportisle
> Security
> Backup + disaster recovery ~
£ Search rules Source == all  Destination == all  Protocol == all  Action == all

> Operations

Priority 1 Name Port Protocol Source Destination Action
> Maonitoring
> Automation v Inbound port rules (7)
> Help 100 AllowAnyCustom27376Inbound 27376 Any Any Any @ Allow m

110 AllowB0-443-5005 80,443,5005 Any Any Any @ Allow g

wind on a3 canc s P Anus FArT Tar ¥

e The option you can see in the image above, HA-PRIMARY-NIC-2/ipconfigl (primary), is a link. The naming is
of course the one we used, and your name for NIC 2 may be different.

e Click the link to proceed and add your IP addresses.

e The next page you will see is IP Configurations.

e Click the Add button highlighted to add an IP address.
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. - -
_ y N 2 5 & jsavoor@edgenexus.io
= Microsoft Azure O Search resources, services, and docs (G+7) D & o &

Home > JS-HACC-HA-VMPRI-UKS-Z1 | Network settings > HA-PRIMARY-NIC-2

HA-PRIMARY-NIC-2 | IP configurations X

Network interface

£ Search

() Refresh
@ Overview
IP Settings
E Activity log 9
A Access control (IAM) Enable IP forwarding D O
@ Tags
Virtual network JS-HACC-VM-UKS-Z1-vnet
' Settings
[ IP configurations Subnet (© HACC_1_Secondary (10.0.1.0/24) 239 free IP addresses v
239 free IP addresses
= DNS servers
@ Network security group Private and public IP addresses can be assigned to a virtual machine’s network interface contraller. You can add as many private and public IPvd addresses as necessary to a network interface, within the limits listed in the Azure limits
" article. Learn more f
{I! Properties
G Locks | Add
»  Monitoring
S Automation Name 1P Version Type Private IP Address Public IP Address
> Help [ ipconfigt 1Pvd Primary 10.0.1.102 (Static)

[ cross-MON-117 ) e mm— Monitoring IP 1Pvd Secondary 10.0.1.117 (Static)

u Private_10.0.1.114 1Pva Secondary 10.0.1.114 (Static)
s Private/Flexible IPs
3 Private_1001.115 1Pva Secondary 10.0.1.115 (Static)

¢ Inthe Name field highlighted in the right-hand section above, fill in an appropriate name for the Private IP
address you are going to create. An example may be something like, Private_10.0.1.114. This name is used
as a tag name within the HACC and makes it easier to recognize.

e The next step is to choose the Allocation type. Select Static.

e Then provide a Private IP address within the subnet for the network interface you are going to add it to.

e Click Add.

e The new Private IP will be added to the network interface.

e You can repeat this process for any additional IP addresses you wish to add.

e Perform the steps shown on the Secondary ADC virtual machine. The result should look like this:

- is: e ws.io i~
| - oo EETTETTTETE ' ]

Home > J5-HACC-HA-VMSEC-UKS-Z1 | Network settings > HA-SECONDARY-NIC-2

i HA-SECONDARY-NIC-2 | IP configurations  * - P

Network interface

S ) aaeen

@ Overview
. IP Settings
E Activity log 9
Po Access control (IAM) Enable IP forwarding @ ]
@ Tags
Virtual network J5-HACC-YM-UKS-Z1-vnet
' Settings
[ IP configurations Gateway load balancer (@ None ~
= DNS servers .
Subnet @ HACC_1_Secondary (10.0.1.0/24) 239 free IP addresses “
@ Network security group 239 free IP addresses
I} Properties
Private and public IP addresses can be assigned to a virtual machine’s network interface controller. You can add as many private and public IPv4 addresses as necessary to a network interface, within the limits listed in the Azure limits
£ Locks article. Learn more f
> Monitoring
+ Add
> Automation
> Help . . .
Name 1P Version Type Private IP Address Public IP Address
[ ipconfigr 1Pvd Primary 10.0.1.112 (Static) 172.165.88.15 (HACC_UKS ElasticlP)

D CROSS-MON-116 | «ff Monlloring IP 1Pvd Secondary 10.0.1.116 (Static)
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Important Information Required to Deploy HACC

We are almost there now and will be ready to deploy the HA Cloud Connector in Azure.

Checklist

1. App Registration

Resource Group

Access Control IAM Roles

Two Virtual Machines with EdgeADC OS Image created
Additional subnet added

Network Interface attached to new subnet on each ADC
Public IP address and any Private IP addresses created

Nooakwd

Information required to proceed

Azure Subscription ID

Directory Tenant ID (found on the HACC App page)

Application Client ID (found on the HACC App page)

App Secret (Noted down earlier when creating the Application Registration)

coop

NOTE: If you failed to store the App Secret, you will need to delete the App Registration and redo it.
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Configuring the EdgeADC

There are several items that need to be configured on the ADC for the HACC app to work.
We will also refer to the ADCs and network interfaces as follows:

e Active ADC will be referred to as Preferred

e Passive ADC will be referred to as Secondary

e The ethO network interface is also referred to as NIC-1
e The ethl network interface is also referred to as NIC-2

Configuring the ADC networking

By default, when the ADC is created it is populated and configured to use the ethO network interface. We
will need to add the new network interface we created earlier and prepare a virtual service for use.

Below you will find the Networking page of EdgeADC.

EDGE NEXUS IP-Services EIHE‘

£ services L) + Basic Setup

i\ Library [+] Name: EADC-HA-PRI

@ View [+] 1Pv4 Gateway: 10,0011 © DNS Server I: | 168.6312916 DNS Server 2:

# System (-] IPVE Gateway: 9 m

£ Clusterin N
9 + Adapter Details

(£ Email Events

Adapter VLAN IP Address Subnet Mask Gateway RP Filter Description ‘Web Console REST

£T History

I ethl 1001102 2552552550 Red Side
IR Licence
E Logaing
O Network
—
™ Power
P security ~ Interfaces
Remove
fsnmp
B Users ETH Type Status Speed Duplex Bonding
ethl [w) aute auto nene
+ Bonding
Advanced
’ 0 Bond Name Bond Mode
& Help (+]

..
We have already added ethl as you can see, but the process is extremely simple.

e Click Add Adapter

e You will see a new line placed under ethO in the Adapter Details section.

e By default, the new line will state ethO, but you can use the dropdown menu to select ethl.

e Once you have done that, you can provide the IP Address that was provided by Azure for this network
interface. In our case, its 10.0.1.100.

e Provide the appropriate netmask and the Gateway IP address. The Gateway IP address normally ends with 1
and as you can see it's 10.0.1.1 in our example.

e Click Update and the networking layer of the ADC will restart.

e You will also need to enter the specific Gateway IP address for ethO.

e |f the Ethernet interface connects successfully, you will see its icon show Green in the Interfaces section.
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Defining the Virtual Services

EDGE NEXUS

p—
I Library L Mode vIP VS  Ena.. IP Address SubNet Mask / Prefix Port Service Name Service Type
o o Stand-alene ® ® o 1001114 2552552550 443 HTTPS affload - PIP1 HTTR(S)
- = 10,0114 2552552550 80 HTTP VIP - PIP1 HTTP(S)
# system e Stand-alone - - F 1001117 2552552550 80 Monitor Real Server Layer 4 TCP
=q . - = 255 ] 88 Mo Layer 4 TCP
usterin:
= . stand-alone ™) ) 7 1001115 2552552550 443 HTTP(S)

(@ Date & Time

B Email Events

5T History §§ Real Servers
=

R Licence
EON Basic  Advanced  flightPATH

B Logging

[ Network Group Name: | Server Group I @® copyServer (@ AddServer

) Power Status  Activity Address Port Weight Calculated Weight Monitor End Point Notes D

F security

¥ snmp

5 Users
# Advanced [+]
& Help (+]

..
In the above image, you can see an example of our configuration. Let’s explain what we have there.
Remember, our network interfaces were defined as follows:

e Preferred ADC
o The ethO0 interface uses IP subnet 10.0.0.0/24 and is allocated IP address 10.0.0.8
o The ethl interface uses IP subnet 10.0.1.0/24 and is allocated IP address 10.0.1.102
o Three private IP addresses linked to eth1: 10.0.1.114 and 10.0.1.115
o One private IP address for the monitoring VIP on eth1: 10.0.1.117
e Secondary ADC
o The ethO interface uses IP subnet 10.0.0.0/24 and is allocated IP address 10.0.0.7
o The ethl interface uses IP subnet 10.0.1.0/24 and is allocated IP address 10.0.1.112
o One private IP address for the monitoring VIP on eth1: 10.0.1.116

eth0 ethl eth0 ethl

Base IP:10.0.0.8
Pubic IP from Cloud

Base 1P:10.0.1.102 Base IP:10.0.0.7 BaseIP:10.0.1.112
Private IP: 10.0.1.114 Pubic IP from Cloud Monitoring: 10.0.1.116
Private IP: 10.0.1.115

Monitoring: 10.0.1.117

Active
Preferred

Passive
Secondary

The two IP addresses you see in red are the ones that will be the flexible IP addresses. As can be seen,
they are currently attached to ethl on ADC Preferred.
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Creating the Monitoring VIPs

There are two methods of creating monitoring VIPs, and these have been highlighted below.

You will need to make sure that you have ONE additional private IP address created and allocated to NIC-2
on each ADC. Provide it an appropriate name such as Monitoring-VIP, as | will refer to it as such below.

Simple App Monitoring

Using this method, we will create a simple monitoring VIP that monitors the availability of a web service on
the Real Server.

e Inthe Virtual services panel, click on Add Service

e Select the Private IP address (Monitoring-VIP) you created.

e Provide a valid netmask and port value.

e Inthe Description, state Preferred-ADC-MVIP

e Select the appropriate Service Type

e Inthe Real Servers section provide the IP address to your real server.
e Specify the port

e Click Update.

If all is ok, then you will see the indicators showing as Green.
Repeat this step on the Secondary ADC but name the VIP as Secondary-ADC-MVIP.
The names will help you identify it when creating the Service within the HACC App.

Cross ADC Monitoring
In this method, we will create a VIP that monitors where:

a. The Preferred monitors the reachability to the Secondary
and
b. The Secondary monitors the reachability to the Preferred

The process is as follows:

e On Preferred ADC (ADC-1)

e Select the Private IP address (Monitoring-VIP) you created.

e Provide a valid netmask and port value.

e Inthe Description, state Monitoring-RS-ADC-1-VIP

e Select the appropriate Service Type

e Click Update

e Inthe Real Servers section provide the IP address to your real server.
e Specify the port

e Click Update.

e On Secondary ADC (ADC-2)

e Select the Private IP address (Monitoring-VIP) you created.

e Provide a valid netmask and port value.

e In the Description, state Monitoring-RS-ADC-2-VIP

e Select the appropriate Service Type

e Click Update

e Inthe Real Servers section provide the IP address to your real server.
e Specify the port

e Click Update.
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On Preferred ADC (ADC-1)

Highlight the click on the MONITORING-RS-ADC-1-VIP you created

Click on the Copy Service button in the Virtual Services panel.

This will make a copy of the VIP

Click Update

In the Real Servers section, change the IP address of the Real Server to the IP address of MONITORING-RS-
ADC-2-VIP

Click update

On Secondary ADC (ADC-2)

Highlight the click on the MONITORING-RS-ADC-2-VIP you created

Click on the Copy Service button in the Virtual Services panel.

This will make a copy of the VIP

Click Update

In the Real Servers section, change the IP address of the Real Server to the IP address of MONITORING-RS-
ADC-1-VIP

Click update

This effectively ensures that ADC-1 monitors ADC-2, and ADC-2 monitors ADC-1 thereby triggering a
failover.
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Installing the HA Cloud Connector

Important

The HA Cloud Connector must be installed and on both ADCs you have in the selected region and zone(s). Each
must be configured individually to talk to the Cloud Provider API to switch the floating IP when needed.

Both ADCs must have their cluster role set to Standalone.

Deploying the HA Cloud Connector

This process is very easy, as the HA Cloud Connector (HACC) App is pre-installed into the Cloud version
of ADC. So, no need to download anything.

You will find the HACC App under Library > Apps. It looks like the image below.

HA-Cloud-Connector (A
HA-Cloud-Connector @
Switch over floating IP of a cloud ADC instance to another ADC Date: 21 Feb 2024
instance upon a VIP failure Order:

Version: 2.0 (build 1340
)

<> Deploy App Store Info

To be able to make the HACC App operational, Click the Deploy button.

Making the App Operational

When an App is downloaded and deployed, it is yet to be operational. Normally, the App has to be given an
IP address in the same subnet as the EdgeADC and ports through which it needs to be accessible. But in
the case of the HACC application, we need to provide it with the IP address of the ethO network interface.

e Navigate to Library > Add-Ons and locate the HA Cloud Connector App.
e It should look something like the image below.

HACC Q

Container Name: HACC I

. Il ’ External IP: 10.0.0.4
. External Port:  5005/tcp

10.0.0.4 is available on ethQ

Parentimage: HA-Cloud-Conne ctor-Edgenex:

al IP: | 1723101

d AL 2024-02-22T11:28:58
Stopped At

Impaort File:  Browse [ Browse

-On

Export Configuration

e Give the Add-On a name @ —the EdgeADC's internal DNS system uses this to refer to the App when
needed.
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Enter the value for the External IP @ This value should equal the Private IP given to NIC1 of the cloud VM

instance.
e Enter a value of 5005/tcp for the External Port €.
e Once you have done this, click the Update button O 1o initialize the App.

e Click the PLAY icon © above to activate the App into an operational state.
Once operational, it will look like the following image and be listed in the Services section as an embedded

App.

Container Name: HACC [H] Parent Image: = HA-Cloud-Connector-Edgenext

Internal IP;  172.31.0.1

. ll ’ External IP: 10.0.0.4
External Port:  5005/tep Started At: | 2024-02-22T11:28:58
10.0.0.4 is available on eth0 Stopped At:

3 Update Import File: Browse [#* Browse
o

o Add-On GUI .
&  Export Configuration

Note the Add-On GUI @ button to launch the App GUI and the Pause App and Stop App buttons. Clicking the
Add-On GUI button will open the App management screen in another browser tab.

Note: You will need to do this on the HA Cloud Connector on each ADC.
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Configuring the HA Cloud Connector for Azure

Logging onto the HA Cloud Connector Console
The first step is to log in and access the management console.

To do this, access the Add-ons section of the ADC using the navigation panel. It can be found in the Library
section.

Locate the HA Cloud Connector App that you deployed. If the fields are blank, you have yet to
operationalize the App. See the section Error! Reference source not found. in the last chapter.

Click the Add-On GUI button to launch the console login page.

EDGE NEXXUS

HA Cloud Connector

Please log in

© Edgenexus

The default credentials are admin/admin for the username and password. You may change this later
within the console if you wish.
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The Cloud Connector Main Page

HA Cloud Connector = 06 @y

NAVIGATION

| Services

Add Service + m Apply Changes B

& Services

5 entries Search:

Monitoring VS Cloud Connection Public Address Preferred Destination Second Destination FailBack  Current Destination Edit Delete

Once logged into the HA Cloud Connector, you will be presented with the main or Home page. It is from
this page that you will perform the configuration of the HA Cloud Connector.

The first step in configuring the HA Cloud Connector is to define the Cloud Connection. The information you
provide will give the HA Cloud Connector access to your Cloud environment, particularly the floating IP it
will need to manipulate.

Defining Cloud Connections

HA Cloud Connector = 06 @y

NAVIGATION

| Cloud Connections - Microsoft Azure

Add Cloud Connection + Apply Changes B

onnections

5 entries Search:
Cloud Connection  Region Subscription ID Tenant ID Client ID Client Secret Edit Delete Test Connection
HACCTest UK South
0fa2d08e-2dad-4¢ Delete W m
Shawing 1 to 1 of 1 entries Previous —

e Click the Cloud Connections option in the Navigation bar on the left of the page and expand it.
e Select Microsoft Azure.
e To add your Cloud Connection, please click the Add Cloud Connection button.
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e You will now see a blank field line that you need to fill in.

Cloud Connection Region Subscription ID Tenant ID Client ID Client Secret Edit Delete Test Connection

” . -

e Add a value for the Cloud Connection name. This can be anything you wish, and in our case we have shown it
as HACCTest.

e Add the Azure Region in which your VMs are located.

e Add your Azure Subscription ID. You can find this in your VM Overview page.

/\ Essentials

Resource group (move) : JS-HACC-VM-UKS-Z1_GROUP Operating system : Linux (centos 8.8)

Status : Running Size : Standard B2ms (2 vcpus, 8 GiB memory)
Location : UK South (Zone 1) Public IP address : 20, 52

Subscription (move) : Edgenexus Azure Virtual network/subnet : JS-HACC-VM-UKS-Z1-vnet/default
Subscription ID :IOfaZd 0a3 IE DNS name : Not configured

Availability zone o1 Health state T-

Tags (edit) * VM_Name : JS_HACC_VM_UKS_Z1

e Next, add the Tenant ID (found in your HACC App Registration overview)

Home > App registrations >

i Edgenexus HA Cloud Connector = - ®
8 e bmpins 3 P s
B Overview
# Essentials
& Quickstart
Display name + Edgenexus HA Cloud Connector Client credentials O certficate, 1 secret
#' Integration assistant
Application (client) ID  : 9fes 'b09 Redirect URIs Add a Redirect URI
Manage Object ID : ds0 2a1f Application ID URI : Add an Application 1D URI
I Branding & properties Directory tenany 1D~ : idee 1d0a | Managed application in ... : Edgenexus HA Cloud Connector

5) Authentication Supported account types : My organization only

Certificates & secrets @ Stanting June 30th, 2020 we will na longer add any new features to Azure Active Directory Authentication Library (ADAL) and Azure Active Directory Graph. We will continue to pravide technical support and security updates but we il no &3
" " g 3 " i i
Il Token configuration longer provide feature updates. vill need to be upgraded to Micrasoft Library (MSAL) and Microsoft Graph. Leam more
o APl permissions
GetStarted  Documentation
@ Expose an API
HL App roles . .. N " . .
o Build your application with the Microsoft identity platform
wners
4. Roles and administrators The Micrasoft identity platfarm is an authentication service, open-saurce libraries, and application management tools. You can create modern, standards-based
authentication solutions, access and protect APls, and add sign-in for your users and customers. Learn more?
M Manifest
Support + Troubleshooting
* % m'" = ;
i .
£ Troubleshooting o 2 .
| 3 a
2 New support request g - E
- v
Siain in ucare in § minutac Canfinura for vaur araanization J

e Next, enter the Client ID (found in your HACC App Registration overview)
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Home > App registrations >

fi Edgenexus HA Cloud Connector = - X

1 Deete ) Encpoints [ Prview features

B Overview
A Essentials
& Quickstart
Display name : Edgenexus HA Cloud Connector Client credentials : O certificate, 1 secret
#" Integration assistant
Application (client) ID {alez 009 I Redirect URIs Add a Redirect URI
Manage Object ID : d50 i2a1t Application ID URI : Add an Application ID URI
B Branding & properties Directory (tenant) ID : #4ee 1doa Managed application in |... : Edgenexus HA Cloud Connector

2 Authentication Supported account types : My organization only

Cortificates & secris @ starting June 30th, 2020 we will no longer add any new features to Azure Active Directory Authentication Library (ADAL) and Azure Active Directory Graph. We will continue to provide technical support and security updates but we will no
longer provide feature updates. Applications will need to be upgraded to Microsoft Library (MSAL) and Microsoft Graph. Leam more

Il Token configuration

< APl permissions
Get Started  Documentation

& Expose an AP

I App roles

Build your application with the Microsoft identity platform

& Owners

&. Roles and administrators The Microsoft identity platfarm is an authentication service, open-source libraries, and application management tools. You can create modern, standards-based
authentication solutions, access and protect APIs, and add sign-in for your users and customers. Learn more?

M Manifest

Support + Troubleshooting @, ]
“® m *=
< ]
22 Troubleshooting b “| 3 .
2 Newsusponreques B . R
el

v

Sian in users in § minutes Confiaure far vour araanization 4

e Finally, we have to enter the Client Secret. As you recall, we defined this when creating the App Registration
and you should have noted this down.

R

Home > edgeMEXUS Limited | App registrations > Edgenexus HA Cloud Connector

Edgenexus HA Cloud Connector | Certificates & secrets = - X
£ Search « &7 Got feedback?
B Overview
& Quickstart ‘Credentials enable confidential applications to identify themselves to the authentication service when receiving tokens at a web addressable location (using an HTTPS.

scheme). For a higher level of assurance, we recommend using a certificate finstead of a client secret) as a credential
# Integration assistant

Manage

@ sppiication ion ceni ecrt: dentials can be found in the tabs below. *

1= Granding & properties
D Authentication . .

Certificates (0)  Client secrets (1)  Federated credentials (0)

Certificates & secrets D

A secret string that the application uses to prove its identity when requesting a token. Also can be referred to as application password.
11! Token configuration
& APl permissions + New client secret
@ Expose an AP| Deseription Expires Value (&) Secret ID
B App rales HACC-Secret-21-FEB-24 2/20/2026 808 a7be [ T
& Ovners

£, Roles and administrators

B Manifest

Support + Troubleshosting

£ Troubleshooting

& New support request

e You finally have to Save and then Apply the changes.

e Next click the Test button to check it works. If an error is shown, check all the settings entered.

e If you see the following error when you perform the test, please check the Role Assignments you defined
earlier.

Connection Test

Connection failed. Cloud: failed to initialise cloud API: Azure: Compute
APl access check failed. Make sure the app has been assigned an

appropriate role..
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Defining Destinations for HA

The next stage is to add the destinations to which the floating IP will be directed in case of failure of a
service or ADC.

& 8-
| Destinations
AddDestinaton + JR—
5 t b
Destination Cloud Connection nstance Network Interface Edit Delete
dest-823ee14bb12¢ ce-c98f7c74902F JS-HACCVM-UKS-Z1_GROUP/S-HACC-VM-UKS-Z1 Edge HACC_1/HACC VM1_NIC2
ADC1-VM1-UKS-21 HACCTest 15-HACC-VM-UKS-Z1 HACC_VMI_NIC2
dest-9dfBaafe11c0 CC-c967c74902F EDGE_HACC_2/]5-HACC-VM2-UKS-Z1 Edge_ HACC_2/)S-HACC-VM2-NIC2-UKS-Z1
ADC2-VM2-UKS-21 HACCTest J5-HACCVM2-UKS-21 IS HACCVM2-NIC2-UKS-21
She

e Click Add Destination
e You will be presented with a blank field entry line comprising a number of dropdown menus.

Destination Cloud Connection Instance Network Interface Edit Delete
7 7 v Save

¢ Inthe Destination field, enter a descriptive value. We have used ADC1-VM1-UKS-Z1, but you can use
whatever you wish.

e Next click the Cloud Connection menu and select the Cloud Connection you defined.

e Next click the Instance dropdown menu and select VM1.

e Next click on the Network Interface field and select NIC2 on VM1.

e Click Save.

For the second definition we will repeat the above steps.

e Click Add Destination

e You will be presented with a blank field entry line comprising a number of dropdown menus.

¢ Inthe Destination field, enter a descriptive value. We have used ADC2-VM2-UKS-Z1, but you can use
whatever you wish.

e Next click the Cloud Connection menu and select the Cloud Connection you defined.

e Next click the Instance dropdown menu and select VM2.

e Next click on the Network Interface field and select NIC2 on VM2.

e Click Save.

Once you have done, click the Apply Changes button.
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Defining Services to be Monitored

One of the key elements of the HA Cloud Connector is its ability to monitor the virtual services that are
running on the ADC. In order to do this, we have defined a monitoring service using the ethO network
interface IP.

B HA Cloud Connector = 006 @v

NAVIGATION

| Services

Add Service + m Apply Changes B

& Services

5 entries Search:

Monitoring VS Cloud Connection  Floating Address Preferred Destination  Second Destination  Current Destination  Fail Back  Edit Delete

10.0.1.117/24:88 cc-46¢d 17659879 10.0.1.114 Preferred Secondary Preferred Disabled

HACC216 Private_10.01.114  10.0.1.0/24 10.0.1.0/24 ZERU

® Monitor Secondary ADC

10.0.1.117/24:88 cc-46cd 17659879 10.0.1.115 Preferred Secondary Preferred Disabled Delete W
elete
® Monitor Secondary ADC HACC216 Private_10.0.1.115  10.0.1.0/24 10.0.1.0/24 Force failover

Showing 1 to 2 of 2 entries Previous Next

e Click Add Service
e A blank field line is presented for entry.

Monitoring VS Cloud Connection Public Address Preferred Destination Second Destination Fail Back Edit Delete

~ v ~ ~ ~ D ~ Save Cancel B

e Click the Monitoring VS menu and select the VIP you defined as the Monitoring VIP. This is the one that used
the ethO IP address of the ADC.

e Select the Cloud Connection.

e Select the floating Public IP address, or the Private IP address you created.

e Select VM1 as the Primary Destination.

e Select VM2 as the Secondary Destination.

e In the Failback field, select Enable if you want to have the HACC App failback to the Primary when the issue
has been fixed, or Disable if you would like the connection to be retained on ADC2, making that the Primary.

e Click Save.

e You can add additional Services for each Private IP that requires switching over to ADC 2.

e Click Apply once done.

Repeat these steps within the HACC App on ADC 2.

NOTE: Please make replicate the entries on both Preferred and Secondary ADCs.

And that is it! HA Cloud Connector has been configured.
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Testing the HA Cloud Connector for Azure

Testing the HA Cloud Connector is very simple. Just follow the procedure below.

1. Navigate to the Network settings page of NIC-2 on the Preferred ADC.

. - -
_ N N 3 I - Jjsavoor@edgenexus.io
= Microsoft Azure O Search resources, services, and docs (G+/) r ooy it |

Home > J5-HACC-HA-VMPRI-UKS-Z1 | Network settings > HA-PRIMARY-NIC-2

i HA-PRIMARY-NIC-2 | IP configurations X

Network interface

5 Search

() Refresh
@ Overview
. IP Settings
E Activity log 9
B Access control (1AM) Enable IP forwarding O O
@ Tags
Virtual network J5-HACC-YM-UKS-Z1-vnet

' Settings

[ IP configurations Subnet (© HACC_1_Secondary (10.0.1.0/24) 239 free IF addresses ~

239 free IP addresses

= DNS servers

@ Network security group Private and public IP addresses can be assigned to a virtual machine's network interface cantraller. You can add as many private and public IPvd addresses as necessary to a network interface, within the limits listed in the Azure limits

o article. Learn more of

{Il Properties

£ Locks | Add
> Monitoring
S Automation Name 1P Version Type Private IP Address Public IP Address
> Help (] ipconfig IPva Primary 10.0.1.102 (Static)

[ cross-MON-117 ) «fm— Monitoring IP 1Pva Secondary 10.0.1.117 {Static)

u Private_10.0.1.114 1Pvd Secondary 10.0.1.114 (Static)
fmn Private/Flexible IPs
] Frivate_1001.115 IPv4 Secondary 10.0.1.115 (Static)

e Note that the IPs are associated with NIC-2 of the Preferred ADC
e Now, go to the IP Services page of Preferred ADC.
e Locate your Monitoring VIP and untick the checkbox.

EDGENSWLS
-

I\ Library e

S

Enabled 1P Address

Service Type

<

- ¥ 10,014 255255255.0 80 HTTP VIP - PIP] HTTP(S)
& Apps Stand-alone - ® & 1001117 2552552550 80 Monitor Real Server Layer 4 TCP
Authentication e 100117 255.255.255.0 88 Moniter Secondary ADC Layer 4 TCP
Cache Stand-alone - e ] 10015 2552552550 443 PIP2 HTTR(S)
flightPATH B

3 Real Server Monitors ISR EY RSP

SSL Certificates

Widget S8 Basic  Advanced  flightPATH

Group Name: | Server Group In @® copyserver ® Add Server

Status Activity Address Port ‘Weight Calculated Weight Monitor End Point Notes D
= i 80 00 Self

@ View

# System
# Advanced
® Help

Qo O ©

e This makes the service status turn RED as the VIP is no longer communicating with the Real Server.
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e Now go to the networking page for NIC-2 for the Secondary ADC.

_ " o Yy & Jjsavoor@edgenexus.io
= Microsoft Azure P Search resources, services, and docs (G+/) s @ & e (

Home > JS-HACC-HA-VMSEC-UKS-Z1 | Network settings > HA-SECONDARY-NIC-2

g HA-SECONDARY-NIC-2 | IP configurations  # X

Network interface

£ Search ) Refresh
@ Ovenview
E Activity log IP Settings
P Access control (IAM) Enable IP forwarding @ O
@ Tags
Virtual network JS-HACC-VM-UKS-Z1-vnet
~ Settings
=1 IP configurations Gateway load balancer @& None ~
B2 DNS servers .
Subnet (O HACC_1_Secondary (10.0.1.0/24) 239 free IP addresses ~
@ Network security group 239 free IP addresses
11! Properties
Private and public IP addresses can be assigned to a virtual machine's network interface contraller. You can add as many private and public IPv4 addresses as necessary to a network interface, within the limits listed in the Azure limits
L Locks article. Learn more o
> Monitoring
+ Add
> Automation
> Help Name 1P Version Type Private IP Address Public IP Address
[ ipconfigr 1Pva Primary 10.0.1.112 (Static) 172.165.88.15 (HACC_UKS _ElasticlP)
LI CROSS-MON-116 1Pva Secondary 10.0.1.116 (Static)
B 1Pv4 Secondary 10.0.1.114 (Static)
= Private/Flexible IPs
5 1Pv4 Secondary 10.0.1.115 (Static)
e You can also check the Services page in the HACC application.
Monitoring VS Cloud Connection Public Address Preferred Destination Second Destination Fail Back  Current Destination Edit Delete
10.0.0.4/24:80 cc-30216ac33472 172.165.88.15 dest-8ce9ffag6adf dest-4361791d5257 Enabled Second Delete &
elete
® Monitoring NIC HACCTest HACC_UKS_ElasticlP ADC1-VM1-UKS-Z1 ADC2-VM2-UKS-Z1

e Traffic is now going to the Second destination that was our Secondary ADC and has now become the
Primary.

The Failback Setting

The Failback setting within the Service definition configures the HACC to do the following:
Enabled Mode

When the Preferred ADC fails, the floating IP(s) are moved to the Secondary ADC.

Once the Preferred is brought online again, the floating IP(s) will be returned to the Preferred from the
Secondary.

Disabled Mode

When the Preferred ADC fails, the floating IP(s) are moved to the Secondary ADC.

The Secondary will now be the Preferred ADC.

Once the failed ADC is brought online again, the floating IP(s) will remain on the Preferred (ADC2).

Should the Preferred fail at a later time, the floating IP(s) will be moved to the Secondary.
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Force Failover by Service

There will be times when you wish to failover the floating IP address, either singly, or in multiples. The
Force Failover button allows this to be done.

g HA Cloud Connector = 06 &v

NAVIGATION

| Services

Add Service + Apply Changes B

& Services

5 entries Search:

Monitoring VS Cloud Connection  Floating Address Preferred Destination  Second Destination  Current Destination  Fail Back  Edit Delete

10.0.1.117/24:88 cc-46¢d 17659879 10.0.1.114 Preferred Secondary Preferred Disabled

. Delete &
Monitor Secondary ADC  HACC216 Private_10.0.1.114  10.0.1.0/24 10.0.1.0/24 Force failover -
10.0.1.117/24:88 cc-46cd17659879  10.0.1.115 Preferred Secondary Preferred Disabled Delete W
1 elete
Monitor Secondary ADC HACC216 Private_10.0.1.115  10.0.1.0/24 10.0.1.0/24 Force failover
Showing 1 to 2 of 2 entries Previous - Next

Clicking the button will force the floating IP address(es) to failover to the partner ADC in a graceful manner.

Force Failover by Destination

You may also wish to fail over all Services from the Preferred to the Secondary. You may also have many
Services that need to be failed over, making it tedious to do it one by one.

To accommodate this, we have provided the Force Failover function on a per Destination basis.

When the Force Failover button is clicked in a Destination table row, all Services which are online and have
that Destination within their definition will be switched to the selected Destination. This is particularly useful
when you have multiple destinations, with multiple Services. For example:

e Service 1: Dest 1 and Dest 2
e Service 2: Dest 1 and Dest 3
e Service 3: Dest 3 and Dest 4

When you click the Force Failover button against an invalid Destination, you will get the following error.

Force Failover X

There are no services matching the failover criteria

Close
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Other Settings

There are a few other settings in the HA Cloud Connector that you may wish to use. These are accessed
using one of the icons displayed at the top right of the page.

ech)udCormector = ﬁ S I
000©

NAVIGATION

| Services
Addservice + Aty s ©

5 entries Search
Monitoring VS Public Address Prefered Destination Second Destination Fail Back Current Destination Edit Delete
172.30.4.134/24:80 35.169.163.125 dest-b601d141531F dest-17030ac5983d Enabled Prefered Delete W
Monitoring NIC1 Elastic P 1 Destination 1 Destination 2

Showing 1 to 1 of 1 entries Previous Next

‘ »

Changing the password
You may change the default password from admin to something of your choice.

To do this, click on the icon €) indicated in the image above to open a menu, from which you must select
Profile.

&k Profile

& Logout

Once selected, you will be shown the form to change your password.
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[o)
~F

User Profile

Enter new password

Current password

Password

Re-type password

Update Profile

© Edgenexus

Provide the current password and enter your new password.

Dark Mode

You can display the HA Cloud Connector user interface in either Dark or Light Mode by selecting the icon
@ . Clicking the icon alternates the display modes.

Full-Screen Mode

If you wish to display the HA Cloud Connector App on full screen, click the icon €). The Escape key exits from
the full screen display.

© 2024 Edgenexus Limited 42 | Page



HA Cloud Connector — for Azure

Installation & Configuration Guide

Technical Support

© 2024 Edgenexus Limited 43 | Page



HA Cloud Connector — for Azure

Installation & Configuration Guide

Contacting Support

The HA Cloud Connector App is provided with full email-based support. We always attempt to provide
support for free Apps within 4 UK working hours.

Please get in touch with support@edgenexus.io and explain your requirements with a full description. It
would also help us greatly if you could provide us with the logs from the ADC and HA Cloud Connector

App.
The logs from the ADC that are required are:

1. Support files — found in Advanced > Troubleshooting > Support Files
2. System Logs - found in View > Logs > Download System Logs

The HA Cloud Connector App configuration is located in the ADC and can be found in Add-Ons > App >
Export Configuration.

Container Name: | ecl Parent Image: | Edgenexus-Cloud-Connector-E

. II External IP: | 172.30.4134 rcernal 1B 1017205
External Port: | 5005/tcp Started At | 2022-12-21 09:37:35
172.30.4134 is availzble on etho Stopped At

miore il [ BTGNS

(0 haconcu [N O e ko
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